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PREFAZIONE

Questo manuale € la seconda edizione di uno precedente, scritto inizialmente per uso
personale dal sottoscritto, un utente come tanti, che poi, vista la buona riuscita, ha deciso
di divulgarlo in modo che altri ne possano usufruire.

E’ infatti esperienza comune che, specialmente all’inizio, chi si avvicina a un nuovo
programma, di una certa complessita come questo, trovi difficolta a proseguire nello studio
specialmente se scritto in altra lingua, e spesso abbandona per insufficiente perseveranza.
Un manuale, gia scritto nella propria lingua, poco prolisso, ma diretto al punto, pud essere
senz’altro un valido aiuto per non abbandonare la prosecuzione dell’apprendimento ed
arrivare al termine, con la soddisfazione di essersi impadroniti di un nuovo potente
strumento di lavoro. Il manuale inoltre offre la possibilita di rinfrescare, con una immediata
consultazione, quello che, appreso in precedenza, si € nel frattempo gia dimenticato.

Il manuale & suddiviso in 13 capitoli, di cui 7 si riferiscono ciascuno ad una specifica
funzione che TARGET 3001 ¢ in grado di svolgere ( Disegno dello schema, Simulazione,
Disegno dl PCB ecc. ). Gli altri capitoli sono complementi e Appendici.

L’accesso ad ogni argomento € immediato: basta selezionarlo nell'indice, all'interno del
capitolo di appartenenza e, con collegamento ipertestuale, richiamarlo con un click.
Questo manuale non ha la pretesa di essere una guida completa, per la quale si consiglia
la lettura dei testi originali di TARGET 3001, ma solo un aiuto alla partenza, scritto da “uno
del gruppo degli interessati” che ha deciso di condividere “i propri appunti”.

Durante il lavoro, ho trovato non solo utile ma anche avvincente il programma di
simulazione SPICE integrato in Target. Dapprima fa un bel po’ confondere, finché non si &
preso un po’ di dimestichezza. Un modo per avvantaggiarsi nel corretto impiego, € quello
di decidersi finalmente a leggere almeno alcuni argomenti del manuale originale SPICE
3F5 reperibile sul web che pero € composto da almeno 300 pagine in inglese.

Per questo, al fine di facilitare 'apprendimento e promuovere l'interesse, in appendice B
ho inserito un estratto condensato per iniziare a usare subito SPICE 3F5, che stimolera ad
andare oltre nell’apprendimento di questo formidabile strumento. Dopo questa lettura
riusciremo facilmente a capire perché alcuni modelli non ci funzionavano, li sapremo
correggere e importare. Addirittura sapremo anche scrivere noi stessi dei facili modelli e
avremo la soddisfazione di vederli funzionare correttamente.

La simulazione SPICE non é un passatempo. Si possono creare schemi anche complessi
e vedere con stupore che la simulazione aveva predetto con ottima approssimazione i
risultati successivamente ritrovati su circuito sperimentale montato a banco. Diventa
senz’altro un aiuto prezioso nella progettazione di nuovi circuiti in quanto la simulazione
predice subito la correttezza del progetto.

Seguono, sempre in appendice, alcuni esempi applicativi.

Nonostante tutta l'attenzione prestata, e la revisione accurata partendo dalla prima
edizione, sicuramente si troveranno ancora errori e distrazioni sparsi qua e la. Me ne
SCUSO € spero non siano poi cosi gravi. Sard grato a chi, accortosene, vorra comunicarlo

al mio indirizzo paolo.pacini.0@alice.it

Firenze, Settembre 2013 Ing. Paolo Pacini


mailto:paolo.pacini.0@alice.it
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1 - DISEGNO DELLO SCHEMA ELETTRICO

1.1 Abbreviazione del mouse e note preliminari:
M1=Click sul tasto sinistro. M1h= Click sul tasto sinistro e mantenere premuto. M2, M2h lo
stesso ma sul tasto destro. M12 entrambi premuti. M11 e M22 = doppio click.

Simbologia usata in questo testo per indicare una sequenza di istruzioni.
Es.: File > New Project > Immettere il nome. Significa: fare click sulla casella File, poi su
New Project, quindi scrivere il nome nella apposita casella che appare.

Nota. In Target 3001 i decimali sono separati da una virgola. Nella simulazione é richiesto
il punto. Per non cadere in confusione, usare sempre il punto, accettato in entrambi i casi..

1.2 Apertura di un nuovo progetto.

File > New Project > Immettere il nome

Poi scegliere il tipo di progetto: con schema elettrico, oppure senza schema, cioé
direttamente il disegno del circuito stampato. Entrambe le possibilita prevedono la scelta
singola o doppia faccia. Una volta fatta la scelta iniziale, non si pud piu cambiare durante il
proseguo del lavoro.

Il progetto aperto, deve essere successivamente salvato File > Save project as... in una
apposita cartella.

Suggerimento! salvare in una cartella contenuta all'interno del programma Target. Seguire
il percorso: C.> Documents and settings > Proprio nome personale gia impostato nel
computer > Dati Applicazioni > ibf > TarV16 > arrivati qui creare la cartella “Progetti”.
Aprirla e salvare il nuovo progetto. Lo scopo di salvare i progetti all'interno del programma
Target € che se vengono salvati altrove, durante la simulazione apparira un fastidioso
messaggio di errore ( giallo ) che non ci leveremo piu di torno. Il messaggio dice: Hint:
Some signal names or component names could cause problems for external simulators.
Viceversa se salveremo il progetto nella cartella di target, e se il nuovo progetto € corretto,
quando apriremo la simulazione apparira un messaggio Assistant incorniciato di verde e
un circoletto verde OK che informa che non ci sono errori.

Tutta questa operazione di salvataggio all’interno di Target pud essere semplificata
semplicemente con File > Save project as template.

1.3 Griglia:

M1 su simbolo dell’occhio sulla barra di dialogo orizzontale. M1 su icona della griglia.
Scegliere il passo in pollici. Accettare il messaggio di immettere 25 mils, perché altrimenti
le linee non combinano col disegno di alcuni componenti. Vi &€ perd un problema: se si
inserisce ( tasto F5 ) la griglia a linea continua, il disegno sfuma e diviene poco visibile.
Conviene allora scegliere la griglia a punti “ Grid as points” e il passo di 25 mils. Oppure
vedi par.1.8.

1.4 Cursore a passi.

Per legare il cursore alla griglia a passi di 25 mils ( o quelli impostati ) nella stessa finestra
selezionare “Cursor snaps on grid”. Il cursore appare ancora muoversi in modo continuo e
non a salti, ma i componenti vengono piazzati a passi di 25mils ( o altro impostato ).

1.5 Cursore “Cross hair”
Per piazzare i componenti allineati, & utile utilizzare il cursore tipo “cross hair” ( croce
sottile come capello ). Il cursore si trasforma in una croce sottile che permette di allineare i



componenti. Per attivare, premere F8 una volta. Due volte aggiunge anche una croce a
45° e tre volte ripristina il cursore senza croce.

1.6 Piazzare i componenti
( chiamati Symbols nel disegno dello schema, Package nel layout del PCB ).
Operazione per inserirli:

e« Con icona - Click su icona dell’amplificatore operazionale al centro della barra
orizzontale

» Dalla tastiera - Premere “INS” sulla tastiera del computer.

» Barra verticale di destra - Selezionare ( con M1 ) “Components”. Scegliere ( con
M1) I'icona del componente che ci interessa. Il simbolo si illumina. ( Se non si
illumina premere Esc e fare click di nuovo ).

Si apre la grande finestra di dialogo “Components” con le varie opzioni di ricerca. Tre Tab
( linguette ) offrono tre diversi modi di ricerca : Quick select, Parametrical e Package
Quick select = ricerca veloce, si basa sulla scelta di una sigla da scrivere nella finestra
“Search”. Nella parte bassa della finestra sono riportate tre immagini: lo schema elettrico
del componente, la sua orma sul PCB e la sua immagine tridimensionale ( se esiste).
Parametrical = permette la ricerca sulla base dei parametri del componente. Utile ad es.
quando si vuole selezionare un componente con caratteristiche specifiche, ad es.: che sia
simulabile o con immagine 3D.

Package = ricerca basata sul package ( codice del contenitore ) del componente.

1.7 Connessione automatica di un componente

Quando si sostituisce un componente con un altro di identica geometria, di solito i
collegamenti non si congiungono automaticamente ai pin del componente. Per collegarli
fare click due volte ( M11 ) su ciascun collegamento.

1.8 Intensificare il tratto del disegno dei simboli

Se il disegno dei simboli appare troppo tenue e non risalta abbastanza, € possibile
intensificarne il tratto. Fare M1 sul simbolo dell’occhio, sulla barra orizzontale, e ancora M1
sull’icona del cerchietto colorato. Appare la finestra di dialogo “Color setting” che offre
varie possibilita di intervenire sui colori degli elementi dello schema, quali il colore dello
sfondo ( background ), della griglia ( grid ) dei piedini ( pins ) dei collegamenti ( signal ) e
dei componenti.

In particolare per intensificare il tratto dei componenti, scegliere un colore piu intenso di
quello di default. Per.es.: si pud scegliere il colore nero $000000 oppure $006600 che & un
verde scuro piacevole nel disegno.

Altrettanto si pu0 intervenire sul disegno del PCB, come riportato nella parte piu bassa
della finestra di dialogo.

1.9 Finestra del Package

Components > Packages. Nella colonna di destra sono elencati tutti i “packages” cioé il
disegno delle orme degli involucri dei componenti sul piano del circuito stampato. Per la
loro selezione, sono filtrabili tramite la scelta effettuabile nelle caselle sottostanti.

Name contains: seleziona il componente in base alle prime lettere del nome inserite nella
casella.

La casella sottostante “All package types” seleziona il tipo di componente ( appare la lista
dei tipi )

La casella sottostante seleziona la libreria: From all package list cioé da tutte le liste
disponibili o appartenenti ad una specifica libreria, ad es.: alla sola Libreria Personale che
avremo precedentemente creato.
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1.10 Le liste dei componenti
Durante il lavoro incontreremo varie liste di componenti, come My Component, User
component, Libreia personale , ecc. Cerchiamo di capire che cosa sono e come si
distinguono tra loro.
Se si apre la finestra Components, si trovano, in alto a sinistra, tre linguette: Search,
Component types and groups, e Component list.
Apriamo Component list e troviamo varie liste di componenti: Recently used components,
User components, New components, ...ecc.
Queste liste di componenti che selezionano e distinguono separatamente la totalita dei
componenti, sono state create per facilitare e velocizzare la ricerca di un componente, ma
servono anche per comprendere il significato e riconoscere ciascuna di queste liste
Se ad es.: ci occorre un componente che, ci ricordiamo di aver utilizzato di recente, invece
di andarlo a cercare di nuovo nelle librerie generali con grande dispendio di tempo, ci
conviene aprire la sola lista Recently used components, scorrerla e trovare subito quel
componente.
Tornando alla descrizione delle liste, parliamo subito della spunta My component, che
spesso mettiamo su un componente della libreria di Target per evidenziarlo.
Questa spunta non crea nessuna lista, serve soltanto per indicare che abbiamo identificato
nella lista di Target un componente di nostro interesse che potremo ritrovare in seguito. Su
questo componente non potremo fare nessuna modifica o personalizzazione, in quanto &
proibito modificare i componenti di Target. Se vogliamo modificarlo e in qualche modo
farlo nostro, occorre prima crearne una copia, facendo M2 sulla casella del componente e
selezionando Create copy of XXX. Poi faremo M2 sulla copia ed inizieremo a modificarla
scegliendo nella lista che appare, il tipo di modifica che ci interessa. Altrimenti potremo
utilizzarlo come €& importandolo dalla libreria di Target nello schema elettrico
Torniamo adesso alle liste di componenti riportate in Component list.
» Recently used components
Raccoglie tutti i componenti che sono stati usati di recente, a qualunque lista
appartengano. Serve per velocizzare la ricerca di un componente, grazie alla nostra
memoria.
» USER components
Contiene tutti i componenti che abbiamo inserito in precedenza nella lista USER, o
facendo copia e modificandoli dalla lista di Target, o che abbiamo creato noi di sana
pianta e li abbiamo inseriti nella lista USER. Quando si copia un componente da
Target, automaticamente il componente viene assegnato alla lista USER.
» New components
E’ la lista dei componenti che sono stati di recente creati o modificati. Serve a
velocizzare la ricerca.
* Recently edited components
Analoga alla precedente con la differenza che si riferisce ai soli componenti
modificati.
e Libreria personale
Questa libreria (0 con nome diverso a nostra scelta) la abbiamo creata noi in
precedenza e le abbiamo assegnato quel nome. Raccoglie tutti i componenti di
nostro interesse ricorrente che abbiamo o prelevato da Target e modificato, o
creato ex novo da noi stessi. E’ simile alla lista USER, ma non € la stessa. Infatti
pud non contenere tutti i componenti che sono stati assegnati a USER, ma solo una
selezione di quelli piu ricorrenti.

Nota n°1: Quando si apre la finestra generale Component, in alto sulla destra appaiono
due caselle: TARGET components e My components.
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La prima casella apre la libreria di tutti i componenti di Target che andranno poi selezionati
con i filtri messi disposizione. Esclude i componenti USER.

La casella My components raccoglie tutti i componenti USER e solo quelli di Target
etichettati in precedenza con la spunta My components.

Nota n°2. Ogni tanto i componenti TARGET vengono aggiornati e modificati dagli Editori
Un cartello ci avvisa che & disponibile I'aggiornamento e chiede se lo vogliamo effettuare.
L’aggiornamento modifica i componenti originali Target, ma non tocca i componenti USER.

Nota n°3 - Per creare una libreria personale andare nella finestra di dialogo principale
“Component”. Selezionare Package > Package sulla barra orizzontale > Enter package in
list > New list > Name of the list > Inserire un nome a propria discrezione per es.: Libreria
Personale.

Per aggiungere un componente dalla libreria di Target alla libreria personale, selezionarlo
nella libreria Target Components, fare M2 e scegliere “Import component in My
component list > Libreria personale.

1.11 Inserimento rapido. Se si vuole semplicemente riportare sullo schema un
componente raffigurato fra le icone della barra verticale a destra, fare M1h sul simbolo e
trascinare nel disegno. In questo modo si sposta il componente selezionato con lo stesso
valore della volta precedente. Invece, facendo sopra M1 si apre la finestra con la ricerca
parametrica di quel componente.
Vi sono anche altre modalita per piazzare un componente, tutte facilmente intuibili:

» Dalla barra orizzontale alta Components > Import symbol.

» Oppure premere il Tab F2.
Il componente sullo schema elettrico riporta disegnata una crocetta che rappresenta il
“‘punto di manipolazione o manico” del componente stesso. In quel punto va posizionato |l
cursore per selezionare o movimentare il componente.

1.12 Selezionare un componente sul disegno.

M1 sulla crocetta del componente ( manico ). Se appare selezionata solo una parte del
componente, e si vuole invece selezionare tutto il componente, premere M2 e spuntare
“‘Always select entire component”.

1.13 Tracciatura dei collegamenti. Sulla barra orizzontale selezionare l'icona di una Z di
colore verde. Scegliere, nella freccetta a destra, il movimento del collegamento: prima
orizz, prima vert. dritto, ecc. Se si vuole che allapertura dello schema sia subito
disponibile I'opzione “collegamento dritto” che & la piu usata, impostarlo con M1 sulla
freccetta. Attenzione: quando si chiude e riapre lo schema, occorre impostare di nuovo.
Collegare ogni componente. Dopo ogni collegamento ciascun componente perde le
crocette rosse presenti nei punti di collegamento. Controllare!

Gli incroci con nodo avvengono facendo M1 quando si passa sul conduttore. Se non si
vuole il collegamento basta passarlo senza click. Per inserire un nodo dimenticato,
scegliere la freccetta accanto alla icona dei collegamenti e selezionare in basso il disegno
del nodo.

1.14 Simboli di riferimento: massa, terra, +Vcc + 12V ecc. scegliere Components >
Place reference symbol. Oppure tasto “r’.
Attenzione! +5V,+12V, -12V, ecc. sono riferimenti che non forniscono una vera tensione al

circuito, durante una simulazione, ma servono solo in disegni complessi, per indicare che
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in quel punto va applicata quella tensione senza stare a effettuare il collegamento con la
sorgente di tensione.

1.15 Etichette di riferimento per collegamenti:

Servono a semplificare il disegno sostituendo collegamenti quali alimentazioni ripetitive ed
altro con etichette di uscita e di ingresso. Esempio uscita di una tensione di alimentazione
e ingressi della stessa in vari punti dello schema.

Selezionare sulla barra alta orizzontale: Components > Place reference symbol. Oppure
tasto “r". Scegliere fra !Sign-IN e !Sign-out. Si apre una finestra in cui sono elencate tutte
le possibilita di collegamento. Scegliere quella che interessa. Ad esempio Vcc. Il nome
Vcc viene riportato dentro il rettangolo del simbolo.

Attenzione : le etichette di riferimento, al pari dei simboli di riferimento, non effettuano dei
veri collegamenti riconosciuti dalla simulazione. Infatti non hanno un modello di
simulazione e quindi non sono simulabili.

1.16 Alimentazione di circuiti integrati.

Per collegare le alimentazioni dei circuiti integrati, selezionare sulla barra orizzontale:
Import components > Import rest of components. In alternativa si pud premere l'icona
dellamplificatore operazionale sulla barra orizzontale, accanto a quella dei conduttori.
Premendo la freccetta appare un pop up che contiene lI'icona REST. Appare la lista dei
singoli stadi del circuito integrato non ancora importati nello schema e quella della
alimentazione che é contrassegnata con una P che segue la sigla, es.: IC1P. Importarla e
collegarla alla o alle sorgenti di tensione. Questo collegamento & effettivo e consente la
simulazione.

1.17 Componenti speciali non facilmente reperibili.

Sorgente di tensione: Finestra principale “Components” > M1 su linguetta “Components
types and groups “ > Voltage and Current > Voltage source ( simulation ).

Oppure: M1 su icona del generatore di tensione nella barra verticale fra i simboli dei
componenti. Nella finestra che appare, selezionare il tipo di sorgente.

Altro esempio di ricerca: Ponte raddrizzatore. Linguetta “Component types and groups”
nella finestra principale della libreria dei componenti > Diode > Bridge rectifier.

1.18 Inserire un testo

Barra orizzontale > Elements > Insert text. Questo per scrivere con il carattere gia
impostato in precedenza.

Se invece si vuole prima impostare il carattere e poi scrivere, premere il tasto delle doppie
virgolette ( ” ) sulla tastiera. Appare una finestra con tutte le opzioni.

1.19 Muovere un componente. Click M1h sulla crocetta del componente ( manico ) e
spostare. Se si sposta solo una parte del disegno, > M2 > M1 su “Always select entire
component”.

1.20 Trascinare parte del disegno. Raggruppare con M1h la parte da trascinare.
Attenzione: i collegamenti interessati al trascinamento sono quelli definiti a destra nella
finestra “Settings”. Se si selezionano piu tracce, queste vengono trascinate.

1.21 Muovere solo il testo di un componente. M2 e deselezionare “Always select entire
component”. Poi M1h sul testo da muovere.

1.22 Ruotare. Click sulla crocetta ( manico ) e tenendo premuto ( M1h ) premere anche il
tasto destro.
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1.23 Cancellare. Click M1 sulla crocetta ( manico ) del componente poi premere il tasto
con le forbici sulla barra orizzontale. Nel caso di linee di collegamento, scegliere prima
quanto di questo collegamento si vuole cancellare. (Vedi par.3—11).

1.24 Assegnare il valore a un componente.

Quando si importa un simbolo gia nel disegno del circuito elettrico, le scritte che appaiono
sono il codice progressivo corrente ( Prefix ) e il valore !Value. Per assegnare il suo valore
es.: 33K, occorre fare M11 sulla crocetta dello schema del componente. Appare la finestra
Change Symbols; inserire il valore nella casella Value.

1.25 Interrompere un’azione non voluta.
* Premere il tasto di Stop sulla barra orizzontale, oppure
» Esc sulla tastiera o M12.

1.26 Undo — Redo ( Non fare — Rifare )

Sono due funzioni molto utili che servono a cancellare I'ultima azione fatta o a ripristinarla.
Le relative icone si trovano sulla barra orizzontale rappresentata da una freccia che volge
a sinistra e una che volge a destra rispettivamente.

1.27 Zoom sul disegno

Per ingrandire il disegno “a riempimento della pagina” fare M1 sul quadrato con 4 freccette
arancione sulla barra orizzontale. Per ingrandire o diminuire, Zoom + e Zoom — & accanto,
sulla stessa barra. Piu semplicemente si pud usare la rotella del mouse: in avanti
aumenta, indietro diminuisce. La rotella € molto pratica durante il disegno: se si vuole
ingrandire un particolare, basta mettere il puntatore in centro zona e girare la rotella: verra
ingrandita / ridotta con continuita quella zona centrata intorno al puntatore.

1.28 Selezione di un gruppo di elementi di un disegno

Per selezionare un gruppo di elementi al fine di modificarli tutti, si racchiude il gruppo
dentro un rettangolo con M1h. Poi si rilascia e si preme il tasto ( e ) che significa edit.
Appare una finestra “Edit the selected elements” con due sezioni, destra e sinistra. In
quella di sinistra sono elencati tutti gli elementi. Quelli da modificare possono essere
selezionati tramite una spunta. Selezionarli e premere OK. Appare ora la finestra; es. se si
e scelto Lines, la finestra & “Change lines”. Premere OK. Poi appare una seconda finestra
es. Change toruses da modificare, ecc.

1.29 La funzione REO ( Reorganization )
La funzione REO svolge funzioni di riordino e di pulizia sia nello schema elettrico che nel
PCB. E’ accessibile

« facendo M1 sull’icona della bacchetta magica sulla barra orizzontale,

» con M1 su Action > Reorganization.

- Rinumerazione dei componenti.

Succede spesso che un componente venga eliminato in fase di progetto. Ad esempio in
un progetto con 30 resistenze, viene eliminata la settima. Tutte le resistenze successive a
questa debbono essere rinumerate, scalando un passo indietro. Per evitare un lungo
lavoro manuale, il procedimento & automatizzato dalla funzione REO. Nella finestra
‘Reorganization” si seleziona nel riquadro di sinistra con M1, prima il simbolo della
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resistenza “R”. Poi si sceglie con M1 su “According to schematic” se questa numerazione
si riferisce allo schema o al PCB. Infine si seleziona una delle caselle:
* Only fill gaps: Se, in una successione, manca un numero, la successione viene
rinumerata eliminando il vuoto. Es.: R1,R2,R4,R5....> R1,R2,R3,R4.....
» Sort by X coordinates: i prefissi verranno rinumerati ordinati da sinistra a destra
» Sort by Y coordinates: i prefissi verranno rinumerati ordinati dall’alto al basso
A questo punto siamo pronti per lanciare la riorganizzazione. M1 su “Start prefix reo”.

- Riorganizzazione del progetto ( Area colorata in verde )

Serve a cancellare la memoria interna. Durante le funzioni Undo e Redo rimangono
memorizzate le immagini precedenti ogni azione in modo da essere sempre disponibili per
un richiamo. Percio lo spazio di memoria rimane occupato anche se gli elementi non sono
visibili. La funzione REO cancella questa memoria e gli elementi memorizzati non sono piu
disponibili. Per attivare questa funzione M1 su “Start project reo. Attenzione: I'azione &
irreversibile.

Inoltre & possibile anche selezionare: Cancella le doppie tracce sia nello schema Delete
double trace segment ( schematic), che nel nel PCB, e cancella i segnali non utilizzati
nello schema Delete futile signals.
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2 — SIMULAZIONE

Il programma supporta modelli primitivi e sintassi di SPICE 3F5 e , in parte, PSPICE.
SPICE3F5 ¢ il programma messo a punto dalla Universita Berkeley in California. ( 1984 ).
PSPICE ( Personal Simulator Program with Integrated Circuit Enphasis ) & un discendente
del precedente, cui & stata implementata la versione digitale.

2.1 Modelli.

La simulazione si svolge con una lista di istruzioni ( Net list ) scritte con una sintassi
accettata da Spice, che forniscono al programma le informazioni dei componenti, dei loro
collegamenti e le istruzioni per eseguire la simulazione.

| componenti sono rappresentati da un modello, che pud essere o un “modello primitivo” o
un modello piu complesso descritto dal cosiddetto “sub-circuito”.

| MODELLI PRIMITIVI gia contenutl nel programma, sono modelli che descrivono con loro
parametri iniziali di default, il comportamento di una tipologia di componente, passivo o
attivo, ( resistenza, condensatore, induttanza, diodi, transistori bipolari, Jfet ecc. ).

Per effettuare la simulazione, a detti parametri di default dovranno essere assegnati i
valori reali specifici del componente. Appena trovato il modello SPICE di un componente
da simulare, per esempio tramite ricerca nel web, TARGET si impossessa
immediatamente dei suoi parametri specifici e li sostituisce automaticamente a quelli di
default del modello primitivo, rappresentati in una lista detta MODELCARD. Si ottiene cosi
un modello di componente che rispecchia le caratteristiche di quello da simulare.

Vedere un esempio di modelcard? Icona ampl.operazionale > BC547 > Search > M2 su
BC547 a sinistra > Symbol, Package, 3D,Simulation > Show simulation model > Edit.
Appare la modelcard con i valori specifici del transistore NPN BC547.

Quando si tratta di un componente non compreso nella lista dei primitivi, ad es:: un
trasformatore, un diodo Zener, un diodo Varicap, un Triac, un SCR, una valvola
termoionica, ecc.. esso puo essere rappresentato con un sub-circuito.

| SUB-CIRCUITI sono modelli realizzati con componenti primitivi che formano un circuito
che si collega all’esterno con terminali di ingresso e uscita. Al loro interno i componenti
sono collegati tra loro con nodi interni e formano una rete che intende riprodurre il
comportamento del componente non primitivo. In alcuni casi la rete di componenti interni
riproduce il circuito equivalente del componente ( trasformatori ) in altri casi vengono usate
sorgenti non linearmente dipendenti per simulare le caratteristiche del componente
( valvole termoioniche ). La rete di componenti viene vista dal programma come una
macro governata dagli algoritmi di SPICE secondo le istruzioni fornite nel listato ( Net list ).
| parametri dei subcircuiti verranno sostituiti manualmente a quelli di default in una
apposita tabella.

Tutti i componenti dello schema che vogliamo simulare, debbono avere registrato in
libreria un modello. Se manca un modello, la simulazione non funziona.

Per vedere se un componente ha gia un modello, selezionare la linguetta “Quick select’
della finestra della libreria dei componenti Components. Nella casella a sinistra del
componente in questione, procedere cosi: M2 sulla fascetta nera User > Symbol,package
3D simulation > Show simulation model. Verificare in Edit che siano impostati i parametri
di simulazione.

Attenzione! Show simulation permette solo di vedere il modello di simulazione, ma non di
modificarne i valori.

Per modificare i valori e renderli permanenti, occorre selezionare Edit simulation model e
non Show.

16



2.2 Fornire una tensione di alimentazione.

Prima di iniziare la simulazione occorre dare tensione al circuito e a